
 

Webcaster and E-Sign 

User Guide 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



   WebCaster and E-Sign User Guide    

 

2 | P a g e  
 

 

An introduction to WebCaster and E-Sign 

 

What is WebCaster? 

WebCaster is an online 1003 mortgage loan application. This allows mortgage companies and banks to 

have an internet presence and have borrowers apply for a loan wherever they may be. This online 

application can be delivered either of two methods. If the company does not already have a website, 

they can use the features within WebCaster to build a professional quality, fully featured, and fully 

functional website. If the customer already has their own customized website, they can still use the 

application and features of WebCaster by easily plugging the WebCaster content into their own pages 

with very little coding required. 

 

What is E-Sign? 

E-Sign is Calyx’s e-signature solution. This allows mortgage companies and banks to have a faster 

turnaround time on getting signatures on required disclosures. E-Sign is functional with many of Point’s 

provided forms and more will be added to the list in the future. The E-Sign process can be started 

directly through the loan file in Point and utilizes WebCaster for easy online interface with the 

documents. Simple click to sign design leaves little room for confusion. Disclosures go out from Point 

and once signed will pull directly back into Point to be stored in the loan file to be kept in one place. 

 

 

User Friendly interface 

WebCaster has a user friendly interface for even the novice user, while still offering options for the more 

advanced user if they require. The WebCaster Administrator is the main control portal for both 

WebCaster and E-Sign.  
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Inside the WebCaster Administration site, the user is given an easy to follow menu to locate any portion 

of WebCaster they may need to edit. Nothing in WebCaster is permanent; the user can make changes at 

any time.  

 

 

 

Reporting is easy with WebCaster. The Administration site gives several easy to navigate reports that 

will allow the user to stay informed on the activity of the site visitors and potential borrowers applying 

on the site. 
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A professional looking website 

WebCaster offers many different themes for the website while making it as user friendly to design as 

well as navigate. Graphical themes allow for preset color schemes with professionally designed images. 

The available color themes give a basic layout allowing the user more control of how their website will 

look. With the color themes, the user can add photos and change the backgrounds, borders, text colors, 

and fonts. A customizable top banner will allow the Administrator to display the company’s name or 

logo. Custom pages allow the administrator to create pages from scratch so the company can add any 

content they need. 

 

 

 

Designed to interface with Point 
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WebCaster is the only online application designed specifically to interface directly with Point. 

Applications can be sent to the Loan Officer via email or be imported directly into Point. The Loan 

Officer also can send and request documents to and from the borrower directly through Point. The 

borrower needs only to log onto the website and upload or download the necessary documents for their 

loan process. 
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“7 Step Setup Wizard” 

 

The “7 Step Setup Wizard” will be the seen the first time a user logs into the WebCaster Admin site. This 

will walk the new user through the basic step to get the website up and running with the user’s 

information. If the “7 Step Setup Wizard” has already been completed and the user wants to return to 

the wizard, this can be accessed from the first page of the Main WebCaster Admin site. You can get back 

to this page by clicking on the gray square at the top left of the site that contains the words “WebCaster 

Administration”. Once on this page click on the first tile labeled “step by step setup”. This will return the 

user to the “7 Step Setup Wizard”.  

• Using IE, browse to the WebCaster Admin site at http://webcaster.calyxsoftware.com 

• Enter the Primary email address set up with the account. 

• Enter the Site password. (If this is the first time accessing this site, the site password will be 

provided on the WebCaster Welcome Email) 

• Enter the site number. (Usually number 1, but not always) 

Upon logging in to the site, you will be taken directly to the “7 Step Setup Wizard”. On the left side of 

the screen there will be a menu numbered 1 through 7. (After completing settings on a page, be sure to 

scroll to the bottom of the page and click on “Next” to save changes.) 

Step 1: Profile 

This page will allow the user to enter the main contact information for the user or company. Fields in 

Rust (orange) are required. This information will populate throughout the website where requiring your 

company information, this also includes on the application itself. 

Contact Information 

• Company Name 

• Address, City, State, Zip Code 

• Email Address 

• Business Phone 

• Fax Number 

• Contact Name 

You will also be able to enter information on any State Licenses the user or company may have. If you 

only want those certain states to show on the application, simply check the box at the top labeled 

“Display only the selected (licensed) states”. This information will show on the License Page of the 

website. Check the box next to the state, then enter the NMLS or License number for that particular 

http://webcaster.calyxsoftware.com/
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state. (If you have a national NMLS or license number that allows you to operate in all states, you can 

put that number in the box for each state and be sure to check all states.) 

Step 2: Themes 

WebCaster has two (2) different types of themes. The Theme is the basic template design and feel of the 

site. This will set the color scheme of the site. 

• Themes 

o Graphical Themes: 

Graphical themes are pre-designed themes with set color schemes and images. These 

images and colors cannot be edited and will relate to the fonts, backgrounds, borders, 

and more of the site. If the user is using a Graphical Theme, all that is needed is to place 

content into the site. 

o Color Themes: 

Color themes are more lenient. These will start out with a very basic setting for the site 

with only colored backgrounds and borders. There will be no stock or default images on 

the color theme; however the user can add images to the content area if they prefer.  

• Designs 

o Regular: 

The Regular design will use the full WebCaster website and will show the selected 

theme. The user will build the site within the WebCaster Admin site. 

o Plug-In: 

The Plug-In option is used when the user had their own custom site hosted elsewhere 

and they only wish to use the application functionality of WebCaster. The Webcaster 

pages can be “Plugged In” to other sites by using the HTML scripting for <IFRAME>. 

WebCaster will provide the links to each of the WebCaster pages, but cannot offer 

HTML assistance in setting up their custom site elsewhere. 

Step 3: Layout 

The first section is to enable Plug-In mode. This is the same as the previous page and will do the same 

thing. 

The Layout section of this page will show a wire-frame representation on the webpage when using the 

full page themes.  

• The sections are Banner, Top, Left, Content Area, Right, and Footer.  

• The Left, Content Area, Right, and Footer sections will have radio buttons to “Display” and “Do 

not display” those sections.  

• The Banner section will be controlled elsewhere and the Content Area will always be displayed. 

Site Design allows the width of the page to be adjusted.  
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• This will range from 700 pixels to 900 pixels, Stretch, or Full Screen.  

• If using 700 – 900 pixels, there will be a colored background around the content of the web site.  

• Stretch and Full Screen will take the content to the full available space of the browser area 

Backgrounds and Borders section is used to edit the area outside of the content area.  

• “Align design within browser” will place the content area either center or left adjusted.  

• “Border width” will adjust the size of the border around the content area.  

• The Border and Background colors can be edited using HTML hexadecimal color codes or a color 

pallet.  

• The “Top Margin” will adjust the space between the top of the window and the content area.  

• The “Internal Border Width” will adjust the spacing between the sides of the browser and the 

content area. 

Step 4: Home Page 

The “Home Page” section will allow the entry and design of the content to be displayed on the first page 

the viewer will see. Depending on the theme selected, there may be two or three boxes to place 

content. 

• “Welcome Message and Company Overview” will be the first box and the top of the home page.  

• “Additional Company Information” will be a shaded box showing at the bottom of the home 

page.  

o This section will have a title bar and can be edited or left blank.  

o This shaded area cannot be removed from the site and therefore the page will always 

have a shaded box at the bottom weather content is place there or not. 

*Throughout the WebCaster Admin site there will be content boxes like these. There will be a toolbar 

above the content area and will have features similar to MS Word. This will allow direct WYSIWYG 

editing of the content. Below the content area is a “Edit in HTML” checkbox. Selecting this will turn 

everything in the content area into standard HTML script and can be edited this way for more technical 

control. WebCaster WILL NOT USE JAVASCRIPT. IF JavaScript is placed into these areas, the script will be 

removed when the site is displayed and will not function. This is by design, not a bug. 

 

 

 

Step 5: Products 
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The “Products Page” is to create a list of the different types of loans the company offers. The products 

can be added, ordered, or deleted from this page. The “Description” can be edited and a “Rate Sheet” 

can be added. Not everyone will use the “Rate Sheet” as the rates will change often. 

Step 6: FAQs 

The “FAQs Page” is for general Frequently Asked Questions. This page will start with standard Calyx 

supplied questions. These can be added to, edited, reordered, or deleted. 

Step 7: Calculators 

• The Calculators Page offers a set of ten different mortgage calculators.  

• The checkboxes allow the option to show or hide the calculators on the site.  

• The box to the right is the description and can be edited with plain text.  

• The calculators “How Much Can I Borrow” and “Rent vs. Own” are the only two calculators that 

can be edited with percentages, rates and explanations of outputs.  

The “Set Default Values in Calculator” section is used to set starting values in the calculators. The 

potential borrower can change the values, but these are intended as a starting point. 

Congratulations! 

Upon completion of the “7 Step Setup Wizard”, you will see a message to complete and go to the main 

WebCaster Administration site. This will also advise the user of what the website address is and will give 

an option to go to the Web Address page to edit it. 

 

** Everything in the “7 Step Setup Wizard” can be edited in the main WebCaster Administration site. 

Nothing in this wizard is permanent. ** 
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WebCaster Administration Main Site 

 

The WebCaster Administration site is where you will edit and control the website and all of the 

functionality of WebCaster. This site will feature a menu on the left-hand side. This will be used to 

navigate to each different section of the site. Most of the sections will be broken down into sub-menu 

categories.  

After making any changes on any page, be sure to click on the “Save” or “Submit” button at the 

bottom of the page before switching pages or the changes will not be saved. 

 

• Site Design 

The Site Design section will contain the most of the design tool for the site. It will allow the use to 

manage the look and feel of the website as well as some of the content that will show on the site. 

o Home:  

Throughout the WebCaster Admin site there will be pages with navigation buttons. These are graphical 

representation of the other sub-menu items. These can be used for navigations, or the left-side menu 

can be used to navigate directly to the location needed. 

o Themes:  

WebCaster has two (2) different types of themes. The Theme is the basic template design and feel of the 

site. This will set the color scheme of the site. 

• Themes 

o Graphical Themes: 

Graphical themes are pre-designed themes with set color schemes and images. These 

images and colors cannot be edited and will relate to the fonts, backgrounds, borders, 

and more of the site. If the user is using a Graphical Theme, all that is needed is to place 

content into the site. 

o Color Themes: 

Color themes are more lenient. These will start out with a very basic setting for the site 

with only colored backgrounds and borders. There will be no stock or default images on 

the color theme; however the user can add images to the content area if they prefer.  

• Designs 

o Regular: 

The Regular design will use the full WebCaster website and will show the selected 

theme. The user will build the site within the WebCaster Admin site. 

o Plug-In: 
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The Plug-In option is used when the user had their own custom site hosted elsewhere 

and they only wish to use the application functionality of WebCaster. The Webcaster 

pages can be “Plugged In” to other sites by using the HTML scripting for <IFRAME>. 

WebCaster will provide the links to each of the WebCaster pages, but cannot offer 

HTML assistance in setting up their custom site elsewhere. 

o Plug-In Setup: 

▪ Plug-in Mode: 

The Plug-In option is used when the user had their own custom site hosted 

elsewhere and they only wish to use the application or page functionality of 

WebCaster. The Webcaster pages can be “Plugged In” to other sites by using the 

HTML scripting for <IFRAME>.  

▪ Framed or Linked Sites: 

This section will show a table with all of the common pages WebCaster has to 

link into a custom website. The pages will only show the content portion of the 

page if the above mode is checked. The color and fonts on the page will still be 

managed by the theme selected. In order to edit the look of the content, adjust 

the theme settings. 

▪ Home Page Link: 

The Home Page Address should be the home page address on the user’s custom 

site that they want the potential borrower to return to after the application is 

completed. If no address is entered, the user will be returned to the WebCaster 

home page. When using a custom site, this will be confusing to the borrower 

and will result in a broken link like situation. 

o Layout: 

This dropdown will contain most of the actual content the user will be placing on their 

page. This will include anything they want their pages to say as well as image and link 

placements on each page. This section will not include the library to upload the images 

or the home page content area. These pages will be located under a later menu item. 

▪ Home: 

• Layout: 

o The Layout section of this page will show a wire-frame 

representation on the webpage when using the full page 

themes.  

o The sections are Banner, Top, Left, Content Area, Right, and 

Footer.  

o The Left, Content Area, Right, and Footer sections will have 

radio buttons to “Display” and “Do not display” those sections.  

o The Banner section will be controlled elsewhere and the 

Content Area will always be displayed. 
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• Site Design Width:  

Allows the width of the page to be adjusted.  

o This will range from 700 pixels to 900 pixels, Stretch, or Full 

Screen.  

o If using 700 – 900 pixels, there will be a colored background 

around the content of the web site.  

o Stretch and Full Screen will take the content to the full available 

space of the browser area 

 

• Backgrounds and Borders section is used to edit the area outside of the 

content area.  

o “Align design within browser” will place the content area either 

center or left adjusted.  

o “Border width” will adjust the size of the border around the 

content area.  

o The Border and Background colors can be edited using HTML 

hexadecimal color codes or a color pallet.  

o The “Top Margin” will adjust the space between the top of the 

window and the content area.  

o The “Internal Border Width” will adjust the spacing between the 

sides of the browser and the content area. 

 

▪ Content Area: 

This page will be used for the Color Themes only. This is where the user can 

adjust the background colors, Header styling, Section Title styling, and Main 

Content Text styling.  In order to make a section apply to the site, the box to the 

left must be selected to turn on those changes. Colors can be determined by 

using an HTML color code or by using the color pallet to the right. Font type, 

size, and weights can be specified by using the dropdown boxes in each section. 

 

▪ Banner: 

The banner will be the area at the top of each page. This will be the same for 

every page on the website. This is used for branding of the site for that 

particular business. This can be a company logo, name, phone number, or 

whatever the user wants to display to quickly identify their page. 

o Banner Option: 

There are three (3) different options for the banner usage in 

WebCaster.  

▪ Option 1: Do not display a banner. 
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This will leave the banner area empty and merely not 

use a banner. The menu will move up to the top of the 

page. 

▪ Option 2: Display text. 

This will give two (2) boxes to show text in the banner 

area. The “Title” and the “Subtitle” boxes will accept 

plain text or minimal basic HTML tags. In the 

description, there will be a link for an HTML tutorial s to 

what tags will be usable. There will also be a preview 

windows which will show what the text will look like. 

▪ Option 3: Display a Graphic Logo or a Flash File.  

This option will allow the upload of an image file to 

display in the banner area. WebCaster will not edit or 

adjust the size of this file. Whatever the size of the 

image in the file is what will display on the page. Any 

adjustment to the size of the file must be don’t with MS 

Paint, Photoshop, or another image editor prior to 

being uploaded to WebCaster. There will be an option 

for “Banner Placement” that will allow of left, center, or 

right adjustment. 

 

▪ Menus: 

This page allows the user to edit the site’s menu items. The menu will show at 

the top of the page, just under the banner area. There are six (6) top level menu 

items and these cannot be deleted or added to.  The top level menu items can 

contain dropdown submenus. However if there is a submenu, the top level 

menu item will no longer be a link, only a submenu container. Any changes to 

the menu will take several minutes to reflect on the site after saving the 

changes. The color of the menu cannot be edited, it is controlled by the theme 

selected. 

• Site Menu: 

This section shows what the menu will look like on the site. This is only a 

representation of the menu. 

• Menu Items: 

This section will show a table that allows for editing of the menu items.  

o The first column is “Menu Item” this will show the text of the 

menu item.  

o “Edit” will allow you to change the menu item text, where the 

menu item links to and if the menu item opens in a new window 

or the same parent window as the site is currently in. 
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o “Insert New Above” will be used for submenus. This will allow 

the user to add new menu items above the previous. 

o “Delete” will be used for submenus. This will allow to user to 

delete that specific menu item. 

o “Add Submenu” will allow the user to add a submenu below the 

specific menu item. 

o “Edit Submenu” will take the user to the submenu level to make 

changes to that submenu. 

o “Order” allows the user to reorganize the menu items either up 

or down on the menu panel. 

 

▪ Left Sidebar:  

The side bar will display content on all pages. This section will have four (4) 

buttons at the top of the section that will always be displayed on the sidebar 

and cannot be moved, reordered, or turned off. These four (4) buttons are 

“Login”, “My Account”, “Apply Online”, and “Contact Us”. The sidebars can be 

turned on or off under the Site Design > Layout > Home menu. The Left Sidebar 

will be turned on by default. 

• Sidebar Content: 

This section will show a content box. There will be the standard text 

editor bar which will allow editing of the content directly within the 

content area. The Edit in HTML check box will convert the content area 

into HTML script for more technical control over the content. 

• Customize Sidebar (Color Theme Only): 

This section is for use only with the Color Themes and any changes here 

will not reflect if the Graphical theme is selected. To make the settings 

show, the user must select the checkbox to the left. Settings will pertain 

to Background color, font color, font type, and button colors. Colors can 

be determined by using an HTML color code or by using the color pallet 

to the right. 

 

▪ Right Sidebar: 

The right sidebar will function exactly as the left sidebar. The sidebars can be 

turned on or off under the Site Design > Layout > Home menu. The Right Sidebar 

will be turned off by default. 

 

▪ Footer:  
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The footer will display on all pages of the website. This section is for company 

information and can contain basic contact information like email address, phone 

numbers, and licensing information. The fields in orange are required fields. To 

make the fields visible on the website, place a check in the box to the left. If 

unchecked, the information will not be included in the footer on the site even if 

the information is a required field. 

• Contact Information 

o Company Name will be the name the user wants to be known 

by on the website. 

o Email Address should be a general address for the company and 

not necessarily a specific loan officer 

o Business Phone should be a general or main company number 

o Fax Number ca be the company’s main incoming number for 

faxes 

 

• Licensing Information 

o License Text is commonly use to display the company’s NMLS 

number 

o Display link to the licensing page will allow the potential 

borrower to go directly to a page listing all of the company’s 

license information 

o Display link to Privacy Policy will allow the potential borrower to 

go directly to the privacy information for the company. Calyx 

supplies a generic Privacy Poilcy with WebCaster, however this 

can be edited by the user or completely replaced if the user has 

their own specific Privacy Policy. 

 

• Footer Image 

This section will allow the user to upload a small image to display in the 

footer. WebCaster comes default with the Equal Housing Lender logo. 

When uploading a new image, it will replace the previous image and 

that will be deleted. The footer section will only support one (1) photo, 

so if multiple photos are required, the user will need to use a third party 

photo editing program such as MS Paint or Photoshop to add the 

multiple images into a single image file prior to uploading into the 

image section. There will be a check box to turn on and off the image in 

the footer without having to delete the image file completely. 

 

• Content 
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o Home Page 

▪ Content 

• This page is where the user will add all of the content that will shoe on 

the Home Page. There will be two (2) or three (3) content areas 

depending on the theme selected. The last content area on this page 

will be the “Additional Company Information” section. This section will 

have a “Title” box located above the content area. On the website it will 

look like a shaded box with the title in the top border of the box. This 

title can be edited, but the shaded box cannot be removed from the 

page. 

▪ Rotator 

The Rotator is an “Animated News” item that can appear at the top of the home 

page. This can be edited with different links to pages on the site or on other 

sites.  

 

• Configuration 

o The Rotator is optional as there is a checkbox allowing the user 

to disable the Rotator.  

o There are 5 different styles to choose from and those can be 

viewed using the “Preview link to the right of each style.  

o The Rotator details allows the user to specify the look of the 

Rotator by adjusting alignment, width, height, scroll interval, 

slide pause, and pause on ‘MouseOver’. 

• Content 

o This page allows for entry of Rotator items.  

o The Add button will create new entries to the rotator including 

the ability to specify where it will point to as a link.  

o The columns on the table include ‘Insert new above’ will create 

a new entry in order above the selected existing entry.  

o Edit will allow changes to existing entries.  

o Delete will remove the existing entries.  

o ‘Order’ will allow the user to numerically arrange the entries in 

their preferred order. 

 

 

o Loan Center 

• Content 

The Overview page is where the user can introduce their business to the 

prospective borrowers. They can explain where and how they do 
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business. This is a rather general page and the user can put in whatever 

their business needs. This page contains a content area box.  

• Loan Status 

WebCaster allows the user to transfer the Loan Status of a loan from 

Point to the website where their borrowers and access and view the 

information. This page will allow the management of that process.  

o Loan Status Introduction  

The Loan Status Introduction is a content area box that will 

show at the top of the Loan Status page. This will be viewed by 

the borrower when they log into the site to view their status. 

o Loan Status Sections  

This area allows the user to determine which parts of the loan 

file will transfer from Point to the website. Not everyone will 

want to show all information to their borrowers during this 

process. To include a section, place a check in the box; to not 

include a section, remove the check from the box. 

o Conditions Introduction  

This area is a content area box to allow the user to explain their 

company’s handling of conditions. Each company may use 

conditions in a different way. This will allow the user to clarify 

what the borrower may be seeing. 

o Loan Status Password  

WebCaster uses three (3) different passwords. The Loan Status 

password is for use when the user is transferring any 

information from Point to the website including updating Loan 

Status, sending documents, requesting documents, etc. There 

will be another link under ‘Passwords’ later in the WebCaster 

Administration menu that links back to this page. 

o Loan Status Update Email  

When the user sends a Loan Status from Point to the website, 

WebCaster will send out an automated email to the borrower to 

inform them of the changes. This email will include a link to the 

website as well as instruction on logging in. This section includes 

a Text Only content area that allows the user to include a 

customized message to the borrower during this process. No 

HTML content can be used in this area as not everyone will use 

an HTML based email. 

 

• Calculators  
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WebCaster comes with ten (10) different calculators to help the 

borrower in their process. These will not guarantee any rates and are 

not intended for a contractual agreement. 

o Home  

This page lists all ten (10) of the calculators and gives a text-

based description box for each. This description can be edited 

for clarification about what the calculator does. The checkboxes 

will allow the user to choose which of the calculators they want 

to offer to their borrowers. The ‘Set Default Values in 

Calculator’ section will allow the user to specify the starting 

points for the calculators. These values can be changed by the 

borrower as they are simply starting points for when the 

webpage loads. 

o Prequalification  

This page allows for the configuration of the ‘Prequalification’ 

calculator page. This will include two (2) scenarios and various 

variables associated with the calculation of the process. This 

page also includes a content area box for the explanation of the 

calculator results. 

o Rent vs. Own  

This page allows for the configuration of the ‘Rent vs. Own’ 

calculator page. This will include certain variable value in the 

calculation of the process. This page also includes a content 

area box for the directions and explanation of the calculator 

results. 

 

 

o Loan Applications 

The Loan Application section of the WebCaster Administration site will manage how the 

submissions of the online applications are handled. This will include how they are 

imported into Point and to whom the applications are sent. 

▪ Content 

• Terms of Use 

This section will allow the user to require the borrower to agree to 

certain terms prior to filing out an application. The user can include the 

‘Terms of Use’ and the ‘Privacy Policy’. If including these, the borrower 

will go to a page prior to being taken to the application. On this page 

along with the ‘Terms of Use’ and ‘Privacy Policy’ they will also see the 

introduction. A content area box is provided to configure that 

introduction. The ‘Terms of Use’ is listed below as a plain text area. 

• Directions 
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A content area box is provided to give any special directions to the 

borrower prior to applying. This can include HTML content if the user 

needs the borrower to follow any links to get disclosures or other 

documentation prior to the application process. 

• Next Steps: Short Loan Application 

This content area box allows the user to inform the borrower of what to 

expect after applying. This page will be seen immediately after the 

borrower submits the loan application. This can include any documents 

the user may need to proceed with the lending process. 

• Next Steps: Long Loan Application 

This content area box allows the user to inform the borrower of what to 

expect after applying. This page will be seen immediately after the 

borrower submits the loan application. This can include any documents 

the user may need to proceed with the lending process. 

• Conformation Email: Short Loan Application 

After the borrower submits the application, they will receive an 

automated email as well as the ‘Next Steps’ page. This is usually the 

same information, only in their email. These are plain-text boxes and 

will not allow HTML content. This area will allow the edit of the subject 

line as well as the message area. 

• Conformation Email: Long Loan Application 

After the borrower submits the application, they will receive an 

automated email as well as the ‘Next Steps’ page. This is usually the 

same information, only in their email. These are plain-text boxes and 

will not allow HTML content. This area will allow the edit of the subject 

line as well as the message area. 

▪ Configuration 

The configurations section allows the user to configure the two (2) different 

application types.  

• Each of these applications will have a checkbox to enable and disable it. 

At least one (1) application type MUST be enabled.  

• The Name box allows the user to change the name of that particular 

application type. Basic HTML can be used in this box to style the text of 

the Name field.  

• Each of the applications will also have a Content Area. This is used to 

briefly describe to the borrower what to expect in the application.  

 

The Long Loan Application 

• The Long Application will have an option of using the Full 1003 or the 

Fannie Mae Streamline 1003. The difference is only a few questions on 

the application.  
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• The Long Application has eleven (11) pages for the borrower to fill out. 

There will be checkboxes to enable or disable each of the pages. The 

first page “Contact Info” cannot be disabled.  

 

▪ Primary Emails 

 

This area operates differently depending on what delivery method is selected in 

the next section. 

 

“Email loan applications to the loan originators” option: 

• Primary Email Address: The primary email address is the default email 

address to which loan applications are sent.  This email address is also 

part of your login identifier. 

• Secondary Email Address(es): Four (4) addresses can be entered to send 

duplicate applications to. Any loan applications sent to the Primary 

Email Address will also be sent to the Secondary Email Addresses.  

 

“Download loan applications directly into Point” option: 

• Primary Email Address: The primary email address is the default email 

address to which loan applications are sent.  This email address is also 

part of your login identifier; any data sent between the WebCaster and 

Point is secured using 128-bit encryption. When configuring Point’s 

Direct Import option, use the Site Password as the Loan Encryption 

Password for the Primary Email Address. 

• Secondary Email Address(es): Four (4) addresses can be entered to send 

duplicate applications to. Any loan applications sent to the Primary 

Email Address will also be sent to the Secondary Email Addresses. Each 

of the Secondary Email Addresses will also require a password to be 

supplied. The password will be used to configure Point’s Direct Import 

option as the Loan Encryption Password. 

 

“Download loan applications directly into Path” option (There are no Secondary 

Email Addresses using the Path option): 

• Primary Email Address: The primary email address below is will be used 

by the administrator to manage your WebCaster account as part of your 

login identifier. 

• Primary Path Account ID & User Name: The Path account ID and user 

name will be used to automatically download loan files into Path under 

the specified user name. 

 

▪ Delivery 
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This section configures how the user will get the applications into Point.  

• “Email loan applications to the loan originators”: WebCaster will email 

individual applications directly to the Primary Email Address, Secondary 

Email Address, and/or Loan Originator assigned to the loan. The 

information is protected by an encrypted password so only authorized 

users can access the file. 

• “Download loan applications directly into Point”: WebCaster will 

download loan applications directly into Point using the integrated 

WebCaster interface. You can download all pending applications in 

batch from WebCaster to Point by clicking the Online Loan Applications 

button in Point. Data transferred between WebCaster and Point is 

secured using 128-bit encryption. 

• “Download loan applications directly into Path”: Download loan 

applications directly and seamlessly to the selected Path MyDesk 

pipeline using the integrated WebCaster interface. Data transferred 

between WebCaster and Path is secured using 128-bit encryption. 

 

▪ Routing 

Selecting a Loan Originator: 

On the loan application, borrowers can indicate which loan originator they 

would like to work with.  A text field or a drop down list for loan originator will 

appear on the loan application, and the data that the borrower indicates will be 

transferred to the loan originator field of the associated Point file. 

Options include: 

• Borrowers do not select a loan originator 

• Borrowers type in a loan originator name (textbox with no list of loan 

originators displayed on the loan application) 

• Borrowers select a loan originator from a list (dropdown list on the loan 

application).  Please note that this will require you to maintain a list of 

loan originators at About Us > Loan Originators > Descriptions 

 

Routing Applications: 

If borrowers are not selecting loan originators, or if you have borrowers type in 

a loan originator name, applications will be automatically sent to the primary 

email address(es). If you are having borrowers select a loan originator from a 

list, application routing options are available.  You can choose to have the 

application emailed to different parties. 

Options Include: 

• Primary email address(es) only (configured in the Primary Emails screen) 

• Loan Originator email address only (configured in Loan Originator 

Descriptions) 
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• Both the primary email address(es) and the specified Loan Originator 

email address 

 

▪ Security 

Data Retention Policy 

WebCaster automatically deletes any borrower data on the system that is more 

than twelve months old.  Here you can configure the system to retain your 

applications for less time.  WebCaster sets an application's retention time 

according to the policy in place at the time the application is submitted. Please 

keep in mind that once an application has been purged, it cannot be retrieved 

again.  Be sure to configure your application retention time to allow you enough 

time to retrieve your applications. Applications can be saved on the server 

anywhere from 1 day up to 365 days. The default is 60 days. 

 

Loan Application Encryption 

This is the Encryption password for the applications sent from WebCaster to 

Point. Changing the password will affect applications generated or resent from 

that point forward. This will not apply the new password to an application file 

that has already been sent out. 

 

 

o Products 

▪ Introductory Content 

• Products & Services: These are Content Areas that will appear at the top 

and/or bottom (Introduction and Footer) of the Products & Services 

page. If you have chosen to not list individual loan products on your 

website then only the Products & Service Page Introduction field should 

be completed. 

• Loan Product APR Calculation Assumptions: The Assumptions for APR 

Calculation apply to all of the loan products that you offer; however, the 

information is used for calculation purposes only and will not appear on 

the website.  

 

▪ Product Details 

• Allows the user to create a list of all of the products (loan types) the 

company offers. To build your list of Loan Products, click ADD and 

complete the screen that appears.  To modify an existing Loan Product, 

click the edit link in the Loan Products List below and modify the 

content. If you'd like to delete a product, click the delete link for the 

Loan Product you wish to delete.  To reorder your list of Loan Products, 
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enter numbers into the order fields, indicating the order in which you 

would like the list to appear. 

• Product rates will not automatically update. These must be entered by 

the user and should be changed as the rates change in order to be 

accurate. If the user desires, the rates can be left out and would 

therefore not require continuous updating. 

 

 

o About Us 

▪ Content 

• Contact Information: This information will appear in the About Us 

section of your site and can also be displayed in your Footer if you 

choose. The company’s address from here will show on the 1003 

application when viewed, printed out, or viewed in Point after 

importing. 

• Company Details: Content Area to provide more details about the 

company to potential customers. Company history, client base, 

reputation, and philosophy are all topics potential customers will be 

looking for. 

 

 

▪ Loan Originators 

 

• Index Page 

In this area, the user will be configuring the opening page or index page 

for the loan originator section.  The index page contains a list of all of 

the loan originators or other personnel whose descriptions or 

biographies are available.  On this administration page, not only will the 

user be providing introductory content, but will also be specifying how 

the loan originator biographies will be displayed.   

o Introduction to Loan Originator Index Page: Content Area to 

introduce the Loan Officers and the company team members. 

o Format of Display of Loan Originator Descriptions/Biographies: 

Allows the user to show all Loan Officers on a single page or give 

each Loan Officer their own biography page. 

 

• Descriptions 

 In this section, you can modify the loan originator descriptions to be 

displayed on the site.  To build a list of Loan Originators, click Add Item.  

To edit a description or biography for a specific loan originator, click on 

the Edit link in the Description column.  To add or change the photo for 
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a specific loan originator, click on the Edit link in the Photo column.  To 

add or change the application routing information for a specific loan 

originator, click on the Edit link in the Application Routing column.  To 

change the order in which the descriptions are displayed or listed on the 

website, fill in the Order numbers and click on the Save Order button. 

 

Note: 

o If using the routing option to send applications to Loan Officers, 

there will be a checkbox for “Require Borrower to Choose a 

Loan Officer.” 

o When completing the Application Routing portion, the “Point 

Loan Officer Name” field must match identically to what is in 

Point under the “Originator” dropdown box and in Point Central 

under “Users”. 

 

 

o FAQs 

▪ Content 

The WebCaster site contains a section where prospective borrowers can quickly 

find answers to Frequently Asked Questions (FAQs). To add an item to the 

bottom of the list, click ADD.  Use the Insert link to add new items above the 

item which is selected within the list, click the Edit link to edit a specific item. 

Click the Delete link to remove an item. To change the order in which the FAQs 

are displayed on the website, fill in the Order numbers. 

 

o Resources 

▪ Links 

• The Resources section of WebCaster provides prospective borrowers 

with a list of organizations and services they will find helpful, such as the 

Department of Housing and Urban Development. To add an item to the 

bottom of the list, click Add Resource.  Use the Insert New Above links 

to add new items within the list, and click on the Edit link to edit or 

delete a specific item. Click Delete Item to remove an item. 

• The Third Party Web Site Disclaimer is the “Speed bump” that shows up 

when the borrower clicks on one of the links on the Links page to take 

them to another website. 

 

▪ Forms 

Provides a list of blank generalized mortgage forms.  

• Introduction: Content Area to explain the use of forms to the borrower. 
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• Forms to Display: A list of selectable and de-selectable forms provided 

by Calyx. These are blank generalized forms and will not show the 

company or borrower information. 

 

o Files 

▪ Home  

To upload files to the WebCaster site, click Add File and complete the screen 

that will appear.  To upload custom pages that maintain the look-and-feel and 

menus of the site, please click Add Custom Page. Click the Edit link to modify a 

specific item, click the Delete link to remove an item, and click the View link to 

view the specific item. 

 

There is a default maximum space of 10Mb for uploading files, images, and 

custom pages. To order more space for files, the user must send an order to 

webcasteraccounting@calyxsoftware.com, and include their Site ID, website #, 

and the amount of space that they would like to add. Each additional 10 MB of 

space costs an additional $10 per month. 

 

The Files area should not be used to upload and store videos. Videos can be 

saved to YouTube and placed on the site using the embed feature and IFRAMEs 

 

• eDocuments & E-Sign 

o eDisclosure & E-Sign Retention Policy 

WebCaster automatically deletes documents that you have sent to the borrower that 

are more than twelve months old. However, you can configure the system to delete 

those documents earlier. WebCaster sets a document’s retention time according to the 

policy in place at the time the document was pushed to WebCaster. After a document is 

deleted, it cannot be recovered. E-Sign law requires that you retain eDisclosures & E-

Sign documents for a minimum of 90 days so that a borrower has time to access and 

review them. The default is 90 days, but can be increased to 365 days. 

 

o eDisclosure & E-Sign Policy 

According to e-signature law, institutions must provide consumers a disclosure policy for 

receiving electronic disclosures. The Content Area allows the user to edit WebCaster’s 

generic policy to conform to the user’s company policy. This policy will display when a 

borrower is asked by WebCaster to consent to receiving electronic disclosures. 

 

o Email E-Sign Notifications to Borrower 

An email will be sent to a borrower when E-Sign documents are sent from Point for 

electronic Signature. The e-mail consists of an introduction, a link to access E-Sign 

mailto:webcasteraccounting@calyxsoftware.com
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requests, and a footer. The subject, introduction and footer can be modified. The emails 

in WebCaster are text based and will not accept HTML content. 

 

o Instructions to borrower: How to upload documents 

Content Area that describes the steps to upload documents into WebCaster. WebCaster 

supports the following file types : PDF, JPEG, JPG, GIF, TXT, DOC, DOCX, BMP, RTF, 

HTML, HTM, TIFF and XML. There is no restriction to the number of documents that 

WebCaster can upload at one time. However, to achieve optimum performance, smaller 

batches in quantity and file size are recommended. 

 

o Email Notifications to Borrower 

An email will be sent to a borrower when documents or document requests arrive from 

Point. The e-mail consists of an introduction, a link to the page where the documents or 

document requests are posted, and a footer. The introduction and footer can be 

modified below. The emails in WebCaster are text based and will not accept HTML 

content. 

 

• Marketing 

o Advertising 

No configurable content on this page.  

This page gives information on how to advertise a web site and bring in potential 

borrowers to view the site and hopefully apply. 

o Search Engines 

No configurable content on this page.  

Gives information on various search engines and how they work and bring views to a 

user’s website. 

o Search Terms  

Search engines use a variety of factors to rank and list web sites. Adding “metatags” and 

changing the title for your Home page may be one way to gain a higher ranking. Note: If 

you are using WebCaster in a framed site, metatags should be included in your main 

site, not in the WebCaster site. For more information about search engines, go to 

Marketing > Search Engines. 

▪ Page Title 

Each webpage on the site has its own page title. This is the text that will show 

on the title bar or tab of a browser. The page title is also used with search 

engines in locating site content. 

▪ Metatags 

Metatags provide information about a Web page such as what the page is about 

and which keywords represent the page’s content. They are not visible, but are 

often used by search engines to find relevant information on the Internet. 

Metatags are split up into keywords and a description, and both may be used by 
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search engines. This section will allow the user to turn on and off the metatags 

for WebCaster pages. 

▪ Keywords 

A search engine will look for keywords to index results in a search query. The 

more keywords a search matches, the higher on the list of results the site will 

be. The home page has a higher chance of being indexed than your other pages, 

and it may be the only page indexed by some engines. Pick between two and 

four important keywords and try to use them 3-7 times for every 100 words on 

your Home page. Enter keywords separated by a comma (such as home loan, 

lowest rate, online loan application, etc.).  

▪ Description 

Some search engines will use the description as part of a site’s summary on 

their results page. Try to use around 150 characters, for your site. Never make 

your metatag more than 250 characters long because some results pages will 

cut it off. 

 

o Google analytics 

Google Analytics provides you with sophisticated tools to better understand your 

website traffic. To use Google Analytics, you must have a Google Analytics account. Go 

to the Google Analytics web site and set up an account. After establishing an account, 

Google Analytics will generate some code that allows it to monitor your web pages. This 

code must be present in the header of each of your web pages. To insert the code into 

each header automatically, paste it into the provided text box. When you click Save, 

WebCaster will place the code into the header of each of your pages. 

 

*Calyx does not have a business relationship or partnership with Google or Google 

Analytics. Calyx does not take responsibility for the results that you receive using 

Google’s tools. By using Google Analytics, you take full responsibility for the results you 

receive. If you have any questions about Google Analytics and how it works, please 

contact Google. 

 

Please be aware that secure pages such as Loan Applications and My Account, cannot be 

tracked by Google Analytics. Use the Visitor Tracking Reports for those pages. 

 

 

• Visitor Tracking 

o Aggregate Report 

A twelve (12) month report of site activity including new accounts, returning users, 

contact info submitted, application submitted, and loan status views. 

 

o Referral Report 
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The Referral Report allows you to view each visitor’s web address and the number of 

times your Home page was accessed. The user can determine the length of time they 

would like to retain the Referral information and select the dates they would like to 

capture. This feature can be turned on or off. The user can search through the data 

using a particular borrower’s email address and/or date range. 

 

o User Report 

Allows the user to view specific details of a borrower’s account or delete the account 

entirely. The user can search through the data using a particular borrower’s email 

address and/or date range. Viewing the account, the users can change the borrower’s 

password, submit a saved application, view the application, delete the application, and 

the Loan Status currently on that borrower’s account. The account will also show the 

specific wording to the Terms of Use the borrower agreed to and when. The user can 

search through the data using a particular borrower’s email address and/or date range. 

 

o Loan Application Report 

This report will show all of the applications that have been submitted on the WebCaster 

site. The table will show the date, borrower’s first name, last name, email address and 

phone number, Loan Officer selected, type of application (long or short), resend option, 

and view option. The user can search through the data using a particular borrower’s 

email address and/or date range. 

 

o Loan Status Report 

This report shows information about the loan Statuses uploaded from Point to the web 

site. The information will include date and time last updated from Point, the borrower’s 

email address, date and time last viewed by the user, delete option, and view option. 

The user can search through the data using a particular borrower’s email address and/or 

date range. 

 

o eDocument Report 

This report will show details about documents sent to and from the WebCaster site. 

Information will include date, borrower’s email address, document description, date 

and time viewed by the user, date and time collected from the user, delete option, and 

view option. The user can search through the data using a particular borrower’s email 

address and/or date range. 

 

o E-Sign Report 

Twelve (12) month report about E-Sign details including requested date, loan number 

(Point filename), borrower name, document package name, sent by name, and total 

number of packages sent per file. This page will also include the number of loan files 
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submitted, fee per file, and total amount due for that month. As of 06/30/2015 it costs 

$2.00 per file used with E-Sign. This is per Point file, not per package sent on a file. 

 

• Administration 

o Billing Information 

The monthly subscription fee for WebCaster and E-Sign Transactions fee is automatically 

charged to the credit card specified. If the user would like to change the credit card that 

this fee is charged to, or if they need to update the expiration date for the credit card, 

they can fill out the form and click on the Submit Data button. All information is 

transmitted over a secure connection to ensure the confidentiality of the information. 

Optionally the user can contact Account Management and update billing information 

over the phone. 

 

o Web Address 

A web address must be supplied for the WebCaster website. The web address currently 

assigned to the site will be listed. If the user would like to change the web address 

associated with the site, they can select from the options listed.  

Changing the Web Address: 

▪ Calyx-Supplied Web Address:  

Provide the first part of the address and select one (1) of seven (7) extensions 

from the dropdown box. This will be the address of the user’s WebCaster site. 

▪ External Web Address:  

Purchase a custom domain name from a provider like register.com, 

GoDaddy.com, or Network Solutions. Configure that address via a-record to the 

WebCaster IP address (as of 06/30/2015 WebCasters IP address is 

38.108.184.171) for both www. and the @root. Optionally the user can set up a 

cname to point to secure.web-loans.com for both the www. and the @root. 

Once the domain name changed have propagated through the DNS servers, 

enter the domain name into WebCaster. This will be the new address for the 

user’s WebCaster site.  

 

*Framing using Calyx-Supplied Web Address option does the same as the first option. 

**If plugging into a custom site, DO NOT put the address of the custom site into 

WebCaster as External Web Address. Use the Calyx-Supplied Web Address instead. 

 

o Licensing 

Configuration page to set licensing information for licensed states.  

▪ License Page Link 

Turns on and off a link to the license page on the footer of the site. 

 

▪ License Page Introduction 
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Content Area to give information about the company’s licensing information. 

 

▪ State Licenses 

Select the states the company is licensed in and place the licensing information 

in the box to the right. This is usually the license numbers or NMLS numbers. 

Once the states are selected, place a check in the box labeled “Display only the 

selected (licensed) states”. This will remove any non-licensed stated from the 

property state box in the address on the application so that the borrower 

cannot apply for a loan in a state not licensed in. 

 

o Privacy Policy 

A default privacy policy is provided. This can be changed to reflect the specific policy of 

the company. This is a text based box and will not allow HTML content. 

 

o Passwords 

▪ Site 

The password used to log into the WebCaster Admin site. Also used for the Loan 

Application Encryption for the Primary Email address when configured as direct 

import. 

 

▪ Loan Application 

The encryption password for applications sent via email delivery. 

 

▪ Loan Status 

The password used with document exchange when sending documents from 

Point to WebCaster, requesting documents into Point from the borrower via 

WebCaster, updating Loan Statuses from Point to WebCaster, and when using E-

Sign. 

 

o Online Payments 

The WebCaster site enables the user to easily provide a "Shopping Center" where 

borrowers can pay for items they choose to offer online or view additional options they 

have for paying fees that are associated with the loan process. A PayPal account is 

required to use the Online Payments options. 

 

▪ Content  

Content area for the introduction of the payments page, selectable “Add to 

Cart” and “View Cart” buttons, content area for the payments page footer, and 

the PayPal email address associated. 

 

▪ Shopping Cart 
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To build the list of shopping cart items, please click Add Item and complete the 

screen that appears. To modify an existing item, click the Edit link in the list 

below, modify the content, and click Update Item. If the user would  like to 

remove an item, click the Delete link for the item wished to delete. To reorder 

the list of items, enter numbers into the order fields, indicating the order in 

which the user would like the list to appear and click on Save Order. 

 

• Help 

Browse and search WebCaster knowledgebase articles. 

• Logout 

Logs the user out of the WebCaster Administration site. 
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WebCaster Document Exchange Training 

 

Document exchange consists of three (3) functions between WebCaster and Point. These are requesting 

documents from the borrower to be sent to the Loan Officer, sending documents from the Loan Officer 

to the borrower, and updating the Loan Status from Point to WebCaster for the borrower to view. 

 

Configuring Point to connect to the WebCaster account: 

Point must first be told which WebCaster account to connect to. This is done in the WebCaster 

Preferences menu within Point. Utilities > WebCaster Preferences. The configurations in WebCaster 

Preferences are also used for the direct import feature of application, but the document exchange can 

be used no matter the delivery method chosen. 

 

 

 

The WebCaster Preferences box has six (6) sections.  

• WebCaster Administration Login Information 

• Loan Application login 

• Loan Application Download Instructions 

• Loan Status Update/Document Send/Retrieve 

• Loan Application Notification Instructions 

• Loan Application Connection Instructions 
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For the Document Exchange use, only “WebCaster Administration Login Information” and “Loan Status 

Update/Document Send/Retrieve” sections are required. 

• WebCaster Administration Login Information 

This is the area that tells Point which WebCaster site to connect to. 

• Loan Status Update/Document Send/Retrieve 

The Loan Status password is used for encryption of the documents and data transferred 

between Point and WebCaster. The Loan Status password is set within the WebCaster 

Administration site. 

 

To configure the Loan Status password in WebCaster, log into the WebCaster Administration site at 

http://webcaster.calyxsoftware.com and follow the left-hand menu to Administration > Passwords > 

Loan Status. Enter the new password in both boxes and click on “Save”. Passwords are five (5) 

characters or more, alpha/numeric, and must not contain capital letters or special characters. 

 

Requesting documents from the borrower: 

When a Loan Officer is working a loan file, there are times they will need to get certain documents from 

the borrower in order to complete their process. These documents can include, but are not limited to, 

driver’s license, bank statements, W2, tax forms, etc. WebCaster provides a way to transfer those 

documents quickly and easily. 

When in a Point file, go to Track > Status in the Point top menu. On this page, scroll down towards the 

bottom to find the “Document Requests” section. This section will have thirty-eight (38) lines. The loan 

officer may request up to thirty-eight (38) documents, and no more as Point will not add additional lines 

here.  
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To add a document request: 

• Double-click on a blank line or single-click on a blank line and click on “Edit” above. This will 

open the “Edit Document Request” box. 

• Complete the dropdown boxes, “Document Category” and “Document Type” based on the type 

of document requesting. 

• Enter a Document Description about the document requesting. 

• Select a “Due Date” 

If you select the checkbox at the top labeled “Required (Show in Loan Checklist)”, the document 

requested will show on the right-hand side if the Point screen in the Loan Checklist. This is optional. 

Once the information is entered, the user can either click on the “Send/Retrieve” button in this dialogue 

box to send the request immediately, or click on the “OK” button at the bottom to add the document 

request to the list. The letter will allow the user to continue adding more document requests before 

sending them all out at once. Once all requests have been entered and back on the Track > Status screen 

above the Document Requests section is a button labeled “Send/Retrieve”. This will allow the user to 

send out all requests selected. (Use CTRL + click or Shift + click to select multiple lines in the Document 

Request section.) 

When clicking on the “Send/Retrieve” button a box will open listing all of the requests to be sent. This 

box will show the borrower’s email address pulled from the Borrower Information page at the top. Enter 

any “Notes to Borrower” needed. At the bottom will be the WebCaster account information from the 

WebCaster Preferences menu. If this has not previously been entered, enter that now and click on the 

“Save Password” checkbox. Then click on “Send/Retrieve” button at the bottom. 
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The first time using the Document Exchange features, the user will get an error message stating: 

“Document cannot be sent because the borrower has not consented to the eDisclosure. Inform the 

borrower to receive electronic documents; they must consent to the eDisclosure in their account 

profile.”  

 

 

 

The user will also get a second error message stating: 

“An error has returned from WebCaster: 3 Code message: Borrower has never accessed the eDisclosure 

consent statement. WebCaster sent a reminder email to borrower. Check the borrower’s status again 

later to send documents. If borrower’s account did not exist on your site when you clicked the 

Send/Retrieve button, WebCaster created an account on behalf of the borrower. The default password 

is the borrower’s SSN.” 

 

 

This process will send an email with a link to the borrower to have them sign into their account on the 

user’s WebCaster site and agree to the eDisclosure. The actual wording of the statement can be edited 

by the WebCaster Administrator on the Admin site. Once the borrower has agreed to the eDisclosure 

statement, the user will need to return to Point and Send/Retrieve the document requests again. No 

borrower’s information is supposed to go out over the internet without the borrower’s consent. 
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Once the borrower has uploaded the requested documents, the user can go into the Document 

Manager in Point under the eLoanFile > Document Management menu. Click on the button 

“Send/Retrieve” and Point will connect to the WebCaster site and import the waiting documents back 

into Point. All documents in Point are stored within the Document Manager. 

Note: When the borrower has uploaded documents into WebCaster to send back to the Loan Officer, 

The Loan Officer will NOT receive any type of notification. The user will have to go into Point and click on 

the “Send/Retrieve” button to see if there are documents waiting. 

 

Sending documents from the Loan Officer to the borrower: 

When a Loan Officer is working a loan file, there are times they will need to send documents from Point 

to the borrower to complete their loan process. This can include any Point forms and any document the 

Loan Officer may have saved on their computer. WebCaster provides a way to transfer those documents 

quickly and easily. 

 

In Point, follow the top menu to eLoanFile > Document Management. The Document Manager is where 

all documents required for a loan file are stored in Point. Point forms, requested documents, and signed 

E-Sign package forms will be saved here. In order to send a document using the document exchange, the 

document must be added into the Document Manager first. 
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Just like in requesting documents, the borrower must accept the eDisclosure and Consent prior to any 

documents being sent to the website. Here we can tell if the borrower has consented or not. At the top 

right of the document Manager will be a notification that reads “eDisclosure Consent: Unknown”. This is 

the initial setting for this prompt as Point has not yet attempted to connect to the website. The first 

time Point connects and the eDisclosure has NOT been accepted, the prompt will change to “eDisclosure 

Consent: No”. Once the borrower accepts the eDisclosure, and Point again connects to the website this 

prompt will change to “eDisclosure Consent: Yes”. Point will only connect to the website when the user 

clicks on the “Send/Retrieve” button.  

 

To add a document into the Document Manager click on “Add”. This will give a box asking whether this 

document is stored on the computer or if it is a Point form.  

 

 

Add File from Computer:  

Selecting “Add File from Computer”  will open a Windows Explorer box to browse for the file. Find the 

file and click on “Open”. The selected file will show in the Document Information Preview window. 

Correctly set Category, Type, and Description boxes.  

The “Signature Required” checkbox indicates that the borrower must sign and return the document 

back to the user. This will automatically create a Document Request as explained previously.  

Note: This will be added to the Document Request list. This list will only have thirty-eight (38) spaces to 

request documents. 

Once all fields on the preview screen are correct click on “Add” and the document will be placed into the 

Document Manager. 

 

Add Point Form: 
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Selecting “Add Point Form” will open the print form screen. Select the form(s) to send from the left and 

they will be added to the panel on the right.  

Note: If adding multiple forms, the user may select the checkbox “Store as one PDF”. This will add the 

documents into the Document Manager as a single file.  

Set Output Option to “Store” and click on “Store”. The selected forms will open in the Document 

Information Preview screen. Correctly set Category, Type, and Description boxes. 

The “Signature Required” checkbox indicates that the borrower must sign and return the document(s) 

back to the user. This will automatically create a Document Request as explained previously.  

Note: This will be added to the Document Request list. This list will only have thirty-eight (38) spaces to 

request documents. 

Once all fields on the preview screen are correct click on “Add” and the document will be placed into the 

Document Manager. 

 

Sending out documents stored in the Document Manager: 

Once all documents are stored in the document Manager, click on the “Send/Retrieve” button. The 

Send/Retrieve box will open. At the top will have the borrower’s email address, there will be a Notes to 

Borrower” section, and the WebCaster account information will be at the bottom.  

 

 

Fill out the “Notes to Borrower” section and click on the “Send/Retrieve” button. Point will connect to 

the WebCaster site and verify if the eDisclosure has been accepted. If not, the prompts will be the same 

as previously with the requesting documents. The email will go out to the borrower requesting them to 
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log in and accept the eDisclosure. At this time, the “eDisclosure Consent: Unknown” prompt will change 

to “eDisclosure Consent: No”. 

Note: No documents will be sent to the website if the borrower has not accepted the eDisclosure.  

If the borrower has accepted the eDisclosure already, the prompt will change to “eDisclosure Consent: 

Yes”, the documents will be sent to the website, and the borrower will receive an email for them to log 

in to their account to get their documents. 

 

 

 

 

Updating the Loan Status from Point to WebCaster: 

Updating the Loan Status is an easier task than those above. The information is pulled from the loan file 

as it was saved in Point. The particular fields to send are configured with the WebCaster Administration 

site under Content > Loan Center > Loan Status.  

 

 

 

The sections that can be sent using Update Loan Status are: 

• Loan Status Tracking  

• Loan Information Tracking  

• Basic Documents Tracking 

• Verifications Tracking 

• Conditions Tracking  

• Other Items Tracking  
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• Contact Information Tracking  

• Notes  

 

To send the Loan Status Update: 

In a Point file, go to Interfaces > WebCaster > Update Loan Status. The WebCaster Loan Status Update 

box will open. Type in any notes to send with the Loan Status in “Notes to Borrower”, the other fields 

should be completed from the Point file or WebCaster Preferences, and then click on “Update”. Point 

will connect to the WebCaster site and transfer the information to the borrower’s account.  

 

If the eDisclosure has not been accepted, the same functionality will occur as stated previously.  

 

What will the borrower see? 

When the borrower logs into “My Account” on the website, they will see four (4) options.  
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• Change Profile Information 

Allows the borrower to change their password for logging in to their account on the website. 

• Loan Application 

Allows the borrower make changes to or continue filling out their loan application. This will not 

update the loan file in Point; it will create a duplicate file if they submit any changes to the 

application here.) 

• View Loan Process 

This is where the borrower will see the updates for the Document Exchange features of 

WebCaster. Tabs at the top will include Loan Status, Loan Disclosures, Document Requests, and 

E-Sign. Clicking on any of these tabs will allow the borrower to see, download, or upload their 

needed documents. 

• Contact Us 

Allows the borrower to send a comment or question to the Loan Officer via the Primary Email 

Address configured in the WebCaster Admin site. 

 

  



   WebCaster and E-Sign User Guide    

 

42 | P a g e  
 

WebCaster E-Sign Training 

 

E-Sign is Calyx’s e-signature solution. This will allow the Loan Officer to acquire signatures on certain 

disclosures quickly and easily over the internet. E-Sign is an add-on to WebCaster and requires the user 

to have a WebCaster account in order to use the E-Sign features. There is nothing to set up or install for 

E-Sign, it is simply turned on for the WebCaster account and uses the WebCaster Preferences already 

configured for Document exchange. 

Note: E-Sign will not work with all Point forms and will not work with any custom forms. 

 

To send an E-Sign Package: 

From any page in Point, click on the Print icon in the menu or File > Print. This will open the Print Forms 

box. Select the Point forms needing an e-signature from the left panel. These will populate into the right 

panel. Change the “Output Option” dropdown to “E-Sign” and click on the “E-Sign” button at the 

bottom. A new E-Sign box will open. 

 

 

The borrower’s email and WebCaster configuration should already be filled in from Point. The Sender’s 

name and Email address can be entered at the bottom. These do not have to be the Loan Officer. If it’s 

the processor sending out the documents, then this should be the processor’s information. (Or enter the 

sender information based on the company’s procedures) The “Company” field will pull from the Utilities 

> Company Defaults > Company Information menu. Each time an E-Sign package is sent; the user must 
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enter a “Document Package Name” and select the “Send as one PDF” check box. Once the package 

name is entered, click on the “Send/Retrieve” button at the bottom. 

Note: If the user does not select the “Send as one PDF” box, all of the forms will go out and come back 

as individual documents. This will cause trouble later as the PDFs will not combine into one when the 

user needs to send them to the lender.  

 

The signing process: 

After the user sends the package out, the borrower, co-borrower, and Loan Officer (depending on 

signatures required) will receive an email. In this email will be a link to click on that will take the signee 

to the documents.  

 

The first thing the borrower/co-borrower will see is the E-Sign Authentication. This will require them to 

enter their date of birth and the last four (4) digits of their social security Number. 
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Note: The Loan Officer will not get the E-Sign Authentication prompts, they will simply be taken directly 

to the next step. 

After the authentication, the user will see the Electronic Disclosures and Signature Consent. Every time 

an E-Sign package is sent, this will be required. Even if they are on the tenth (10) E-Sign package, they 

user will have to agree to this disclosure. Click on the “Accept” button at the bottom of the page. 

 

 

After agreeing to the disclosure, the user will be taken to the documents to be signed. If the sender 

clicked on the “Send as one PDF” check box, all of the forms will be listed as one scrollable web page. 

There will be arrow buttons on the left showing that there are required signatures remaining to be 

signed. The signature lines will be marked by a yellow tag. To sign, click on the tag. Once signed, the tag 

will turn green. Proceed on through all of the documents and click on all yellow tags. 
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Once all tags are signed, the user will get a box saying the process is complete. Click on “Exit e-SignLive” 

and close the browser, the process is complete. 

 

After all parties have completed the signing process, all parties will get an email with a link showing that 

it has been completed. The borrower and co-borrower will have the opportunity to download the signed 

documents and print them off for their records. 
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The Loan Officer’s email will have instruction on how to import the documents back into Point. 

 

 

 

Importing E-Sign package back into Point: 

Once all of the documents have been signed and the completed emails have been received, the E-Sign 

package can be retrieved back into Point. These will be found in the Document Manager as all 

documents will be stored. Open eLoanFile > Document Management and click on the “Send/Retrieve” 

button. Point will connect to the website and pull in any documents waiting there. The documents will 

import directly into Point without requiring the user to preview the each document. When the import is 

complete, the user will get the Document Transaction Status box showing “Success” of the documents 

importing.  
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After importing the E-Sign package back into the Document Manager, there will be an additional 

document that comes with it. This is the E-Sign Evidence Summary. This document is required to be 

given with all e-signed documents. This is what makes the e-sign process valid.  

After importing the E-Sign package back into Point, there will appear to be duplicate documents. When 

beginning the process, Point must store the documents in the Document Manager in order to send them 

to the web site. Pulling the signed documents back into Point, they will have the same document names. 

The difference is under the “Received From” column. The signed documents will say “E-Sign” and the 

unsigned documents will show “Point Generated Form”. If desired, the user can delete all of the E-Sign 

documents showing “Point Generated Form” as these are no longer needed. 
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E-Sign package not coming back into Point?: 

If the Loan Officer is not receiving the email stating the E-Sign package is complete and no documents 

come into Point when clicking on “Send/Retrieve”, then the signing process is not complete. Someone 

has not signed something. This can be verified in the Webcaster Admin site. Follow the menu to Visitor 

Tracking > eDocument Report. Find the documents in the E-Sign package in question and look at the 

column labeled “Collected from User”. If there is a date and time, then all of the documents in that E-

Sign package have been signed by all parties needed (borrower, co-borrower, and Loan Officer). If this 

field is blank, at least one person has not signed at least one signature line in the E-Sign package. 
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Setup Steps to Configure Point for use with E-Sign on WebCaster QA 

Server (Internal accounts only, not for customers) 

 

These Outlined steps will get E-Sign, eDocuments, Loan Status, and WebCaster 

Desktop working.   

 

Access Sites: (Optional, if you have forgotten your password) 

1. Go to https://webcasterqa.calyxsoftware.com and click forgot your password 

2. Type in your email Address and site # and click submit 

3. WebCaster@calyxsoftware.com will generate an email to reset and login to your QA Production Site 

4. Once Logged in go to Administration > Password 

5. It Is recommended to reset and update all passwords ( Server was scrubbed of all personal data 

when setup) 

 

Edit WebCaster.CFG 

1. Edit the “WebCaster.CFG” in the C:\WINPOINT\tables directory 

2. Change the addresses in this file from https://webcaster.calyxsoftware.com to 

https://webcasterqa.calyxsoftware.com  

Update Hosts File 

1. Go to the following windows directory C:\Windows\System32\drivers\etc 

2. Right click on the Hosts file and click “Open” 

3. Open With Box will appear, select “Notepad” and click the “Ok” Button 

4. Copy the follow settings into the host file 

# New Esign Production 

38.108.184.180 secure.web-loans-qa.com 

38.108.184.181 webcasterqa.calyxsoftware.com 

38.108.184.182 webcasterqa.calyxsupport.com 

38.108.184.183 wapi.web-loans.com 

38.108.184.180  Enter Your Site URL HERE 

5. Replace “Enter your site URL Here” with your Webcaster Site web address 

6. Click File > Save 

7. Close out of the hosts file. 

https://webcasterqa.calyxsoftware.com/
mailto:WebCaster@calyxsoftware.com
https://webcaster.calyxsoftware.com/
https://webcasterqa.calyxsoftware.com/
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Update the Webcaster.ini file 

1. Login to Point to download and update your PointCentral User Settings 

2. Go to Utilities > WebCaster Preferences 

3. Enter All your Login & Site Information 

4. Browse to the “AllUsers Folder”  C:\Users\UserProfile\AppData\Roaming\Calyx 

Software\Point\AllUsers 

5. Open the Folder that matches your Point Central Login 

6. Open your WebCaster.ini file 

7. Replace the following lines to match these URL 

AdminLogin=https://webcasterqa.calyxsoftware.com/ 

Host=https://wapi.web-loans.com/wapi.asmx 

WCDesktopUrl=https://wapi.web-loans.com/wcdesktop.asmx 

WapiKey=D7A7222FDF8D2568D17747E8A69E8497210B53B7 

8. Save the file and then right click and make this file read-only. 

Update Internet Options 

1. In Internet Explorer go to Tools > Internet Options 

2. Click on the Advance Tab 

3. Make sure that “Check for Server certificate Revocation” is unchecked 

 
 

 

 

 


